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WinChime (TM) plays the peaceful sounds of wind chimes, using the MIDI 
capabilities of your sound card.
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Getting Started

When WinChime comes up for the first time, the instrument will be Tubular Bells.    Click on 
the "Play" button.    If you hear pleasant-sounding bell sounds, then your set-up is already 
compatible with WinChime.

(If, instead, you hear a clunky sound with little sustain, more like a Xylophone than Tubular 
Bells, then click on menu Options -> Configure... -> Midi -> 0-Based Patches.    If this 
changes the sound to a more pleasing bell, then click on File -> Save as Default Settings. )

If this doesn't fix your sound problem, refer to Troubleshooting.

WinChime does not automatically save program settings.    If you make a configuration 
change that should be permanent, remember to click on File -> Save as Default Settings.

Assuming you have the correct Tubular Bell sounds, it's time to experiment!    Try changing 
the various Wind, Pitch, Volume, Instrument, and Scale controls and see what happens.



Controls
Main Window
Volume
Wind
Pitch
Instrument
Scale
Play
Stop
Exit

General configuration dialog
Play at start-up
Minimize at start-up
Always on top
Taskbar Tray Icon

Timer configuration dialog
Enable Timer
Fixed Play Length
(fixed play length) minutes
Random Play
(random play) average play minutes
(random play) average sleep minutes
Fixed Play Time
start time
stop time
start time 2
stop time 2

Screen Saver configuration dialog
When screen saver starts
Start sound
Stop sound
No action
When screen saver stops
Start sound
Stop sound
No action

MIDI configuration dialog
MIDI output driver
Instrument patch numbering



Controls average loudness of the notes.

If the notes are not loud enough even with the volume at maximum, look for a software 
utility, usually called a Mixer, that comes with your sound card, with separate controls for 
volume for MIDI, .WAV, etc, plus an overall volume control. Proper adjustment of the MIDI 
and overall volume control in this utility should solve the problem.



Defines how often notes are played, on average.

Use the Timer settings of Random Play to simulate "Gusts" of wind.



Determines the average pitch of notes played.

For a particular instrument setting, some values of pitch sound better than others for a 
specific sound card.    Experiment to find the optimum settings for your preferences.



Maps a particular MIDI instrument sound to the chime notes.

These instrument sounds vary in quality among different sound cards, but typically Tubular 
Bells and Vibraphone sound best as chimes.

It is possible to use other instruments besides the selections defined by WinChime.    Simply 
enter the MIDI number for the instrument in the edit control of the Instrument combo box.

A list of instruments and their numbers is available in your sound card manual, or (in Win3.1)
by going into Midi Mapper in Window's Control Panel by selecting Patch Map and Edit.    (You 
may have to increment or decrement the instrument number by 1, because of differences in 
MIDI Patch Assignment tables.)



Selects among several subsets of tones for your wind chime.

Major
The Major scale, or Ionian, is the most common in modern Western music.

Minor
The Minor scale is the Aeolian medieval mode.

Funky
"Funky" is one of several jazz/blues scales, with the characteristic "blue" notes of sliding 
pitch.

Ritsu
Ritsu is a pentatonic scale of ancient Japan (pre 1500AD).

Yoo
Yoo is a a Japanese scale from the Edo period (1603-1868AD).





Begin playing sounds.

Start sound output.Alternate ways of starting sound include a command on the system 
menu, clicking on the taskbar tray icon, and using the built-in timer.



Stops all sound being produced by the application.

Stop sound output.Alternate ways of starting sound include a command on the system 
menu, clicking on the taskbar tray icon, and using the built-in timer.



Turns off all MIDI notes and exits the application.



Automatically begin playing sounds when program starts.



Start program as icon.



Keep program window on top of other windows.



Place application icon in taskbar tray.

This option is useful when the program is minimized for long periods of time, and reduces 
clutter on the taskbar.

Clicking the tray icon toggles sound output.    Double-clicking opens the main WaveSong 
window.    Right-clicking on the icon pops up a control menu.



Toggles enable of the built-in timer function, which is set up in the Options->Preferences-
>Timer command.    When enabled, a check mark appears next to the Enable Timer menu 
selection.

The timer enable may also be toggled by the accelerator key control-T, or by a control on the
Timer setup dialog.



Enable Fixed Length timer controls.



How long program will play before stopping.



Enable Random time length timer controls.



Average active play time for random timer.



Average silent time for random play.



Enable fixed timer controls.



Enter time to start sound.



Enter time to stop sound.



Controls what action is taken when screen saver activates.



Sound starts when screen saver activates.

Use this option if you want to add sound to your screen saver.



Stop sound when screen saver activates.

Use this option when you don't want sound with your screen saver.



Take no action when screen saver activates.



Controls what happens when screen saver exits.



Start sound when screen saver exits.



Stop sound when screen saver exits.



Take no action when screen saver stops.



Selects the MIDI device driver to be used by this program from the list of drivers presently 
installed in your system.

MIDI Mapper is the recommended MIDI device.



Selects whether standard MIDI instrument patches should be numbered starting with 0 or 1.  
For the vast majority of sound cards and MIDI configurations, choose 1.



Menu

File
Open Settings
Save Settings As
Save As Default Settings
Save Midi File As
Play Midi File
Exit

Timer
Enable Timer
Setup Timer

Options
Configure

Help
Contents
Using help
Register
Purchase
About



Starts open-file dialog for settings file, with default extension .wch .    This (ASCII-readable) 
file contains control setting information for volume, wind, instrument sound, etc.



Saves current settings (wind, volume, instrument selection, etc.) as a WinChime settings file,
with default extension .wch .

To save as the default settings to be loaded at application start-up, use the next menu 
command: Save As Default Settings.



Saves current control settings (volume, wind, instrument selection, etc) as the default 
settings, which will be automatically loaded upon application start-up.



Use the current settings (volume, wind, instrument selection, etc.) and generate a MIDI file, 
with default extension .MID.    This file can be played by any Windows-compatible MIDI 
sequencer, or by other MIDI sequencers by appropriate mapping of patches.



Allows the user to select a MIDI file, and then plays it with Windows' built-in MIDI file 
sequencer.



Turns off all MIDI notes and exits the application.



Activate timer set-up dialog.



Activate Configure dialog.



Starting point for on-line documentation.



Shows the standard Using Help directions for Windows Help.



Shows how to register this program.

 Just do it!



Shows how to purchase this program.



Shows general information about this program.



Troubleshooting

Why don't I hear anything when I click "Play"?
· Check to see that your sound card is configured properly, with all necessary drivers installed.    As a 
quick test, click on the object below, which will play a MIDI file using Windows' built-in MIDI file sequencer.

 

· Check the volume setting within WinChime, then look for a utility that comes with your sound card 
which controls overall sound volume and sound balance.
· Go into Windows Control Panel, and then enter Midi Mapper.    If Show Setups is selected, then you
should be in Base or Extended.

Why do I hear the wrong instrument?
· Refer to the instructions above about Midi Mapper.
· Click on Patches.
In case you get a different instrument sound than expected,

1) experiment with the Options|0/1 Based Patches menu selections,
2) (Win3.1 16-bit version) CHECK THE MIDI MAPPER!

The MIDI Mapper, located in the Control Panel, MUST be set to either Basic MIDI or Extended 
MIDI.    Also, click on Patches for an explanation on differences between Instrument number 
assignments found in different sound cards.

Why does it sound strange at these settings?
For many sound cards, some MIDI instruments only sound "good" within a particular range of
pitches.    For example, Tubular Bells may sound fine one octave below middle-C or above, 
but may be an unusable growl at lower pitches.

WinChime sounds different on my friend's computer.
Different    sound cards may sound vastly different with the same MIDI settings.    Even with 
the same sound card, some manufacturers make available updated drivers which may 
change the quality of MIDI sounds.



Advanced Topics

Shortcuts and Expert User Info...
To toggle between Play and Stop, use the right mouse button.    This is especially handy 
when the application is minimized: just right click on the icon.

WinChime can accept a settings filename as a command-line argument.    This is useful to 
start up WinChime from some other program like a Windows-batch utility or time-scheduler.   
If this filename argument is present, WinChime starts playing immediately after initialization.
The command invocation looks like:

<path>\winchime    <path>\filename.wch 

It's possible to use ANY Midi    instrument with WinChime, not just the instruments provided 
in the Instrument listbox.    Simply click on the Instrument edit control and enter an integer 
between 0 and 127, corresponding to the MIDI instrument number.    A table of instrument 
numbers is available in the Midi Mapper patch map controls.    Alternatively, just experiment 
with different numbers!

Sources for "real" wind chimes...
Woodstock Chimes are offered by several mail order companies.    These folks make several 
quality designs.

One mail order company which carries Woodstock Chimes is ANYONE CAN WHISTLE, PO Box 
4407, Kingston, NY    12401.    Their telephone number is 1-800-435-8863 [ Information is 
current as of 1995.]    Along with wind chimes, ACW sells all manner of fascinating sound-
making devices.

Sagebrush Systems has no connection with either of these companies.    We simply like their 
products, and are happy to recommend them to you.

Pointers to similar/related programs...
The following programs may be found on CICA and wherever fine Windows 
shareware/freeware is distributed.    Each takes a different approach to stochastic or 
algorithmic music.    (Release numbers may change;    information current as of this writing.)

· alcomp11.zip    Aleatoric Composer Music System for Windows
· chimes.zip    Constrained random notes through MIDI (freeware, source)
· impvz120.zip    Improvise 1.20, algorithmic real-time MIDI composition

More information about wind chimes...
To learn more about the physics of wind chimes, refer to: "Wind Chime Physics", Forinash, 
Richie, and Jones, American Journal of Physics, 1990, v58, n1, January, p82(2).

For more information about the physics and design of bells, check out:
"The Physics of Musical Instruments", Fletcher and Rossing, Springer-Verlag, chapter 21, 
"Bells".





Registration and Support
If you have already paid for any    version of this program, and need a registration code for future 
updates, go to UPDATES.

If you have not purchased this program, you may use WinChime for 30 days.    If you wish to 
use this product beyond the 30 day trial period, you must register.    
License agreement.

HOW TO PURCHASE

Purchasing WinChime gives these benefits:

· You will receive a registration code, by e-mail if possible, which will instantly convert your program 
into Registered Mode, disabling all registration reminder features. This registration code will be good for 
several updates, so you can easily continue to obtain improved versions of the program via the Internet or
other distribution channels.    The latest versions of our programs may always be found at 
http://www.sagebrush.com/~sells/
· You will receive the latest and greatest version of this program, if needed.
· Several free updates for Windows95 versions of this program. (Modest shipping charge.)
· Several free updates for Windows 3.1 releases of this program. (Modest shipping charge.)
· Free mail support, and free e-mail support at sells@sagebrush.com .
· E-mail upgrade announcements and new product announcements.
· Registration is the right thing to do.    Registering allows us to continue upgrades to the program and
introduce new products.

Questions?
If you have any questions, feel free to contact us at sells@sagebrush.com or our postal 
address: Sagebrush Systems, Inc., PO Box 3094, Corrales, NM USA    87048, or visit our Web 
site at http://www.sagebrush.com/~sells/



How to Purchase This Program
This edition of WinChime costs $14.95 US (base price, standard edition unbundled). We offer
these ways to purchase:

Check or Postal Money Order-- Mail
Send a check or money order by mail.    We really appreciate when our customers use this 
order method, as it keeps our overhead costs low so we can continue to offer quality 
products at a low price.      We do not charge a shipping or handling fee to U.S. customers 
using this this method of payment.    
International postal money orders are a convenient payment method for our valued non-
USA. customers.

Mail-Order Registration Form

Credit Card-- Internet
If you are comfortable with purchasing on the Internet, point your Web browser to 
                    http://www.sagebrush.com/~sells/    
 A secure Web server is available for handling your credit card transaction.

Credit Card-- 800 number
You can order with MasterCard, Visa, American Express, or Discover from PsL, Public 
(software) Library, by calling 800-2424-PsL or 713-524-6394 or by FAX to 713-524-6398 or 
by CIS Email to 71355,470.    You can also mail credit card orders to PsL at P.O Box 35705, 
Houston, TX    77235-5705.    
THESE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY!!!!
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS.
Any questions about the status of shipment of the order, refunds, registration options, 
product details, technical support, volume discounts, dealer pricing, etc.,    must be directed 
to Sagebrush Systems, P.O Box 3094, Corrales, NM 87048, sells@sagebrush.com .    
To insure that you get the latest version, PsL will notify us the day of your order and we will 
ship the product or registration code directly to you.    The price using this method of 
ordering is $14.95 plus $2.00 handling. 
Refer to item number #11885.    Please use the item number when ordering, to avoid any 
possible confusion.

Retail
Sagebrush programs may be available in retail stores in some areas, sometimes bundled 
with other software or hardware.

What You Get
When you purchase this program, here is the registration benefits you receive:

Registration



WinChime v2.x/v1.x Registration form
        Mail to:                                                                                                                                                              
code24

Sagebrush Systems
P.O. Box 3094
Corrales, NM      87048

_________________________________________________________________________________________
Name

_________________________________________________________________________________________
Address

_________________________________________________________________________________________
City,                                                            State                                                  ZIP                                                                  Country

_________________________________________________________________________________________
Phone Number                                                                                                                                              Internet Address

Where did you obtain your copy of this program?      (Please be specific, so we can insure all 
our distribution sources have the latest version.    If you found this program by our Web 
page, how did you find our Web page?)
____________________________________________________________________________

_______      Yes, please notify me of major new releases.    (Check if applicable.)
_______      Yes, please notify me of new Sagebrush Systems products.    (Check if desired.)

_______    I don't have Internet access.    If this is not the latest version, please send it.
_____ 3.5" double density floppy
_____5 1/4" double-sided double density floppy

Mark payment type:
_____ Check (drawn on a U.S. bank in U.S. funds)
_____ American Express money order in U.S. funds 
_____ International Postal Money Order in U.S. currency 

                                                                                                  (available at post offices world-wide)

Quantity ________    x    $14.95 $__________

NM residents add $.92 gross receipts tax $__________

TOTAL $__________

On the back of this form, please feel free to write down any comments, suggestions for 
improvements, bug reports, kudos, and questions.

                                    Thank you for your order!!!!!!!!!!



More Neat Stuff

If you like this program (or even if you don't), be sure to check out these other software titles
from Sagebrush Systems!
Programs are available from our Web site at 

http://www.sagebrush.com/~sells/ 
and from ftp sites such as ftp.winsite.com and ftp.simtel.net

WaveSong for Win95, WinNT4, and Windows 3.1
Relax to the sounds of thunder, crickets, waves, and rain.    WaveSong is a nature-sound 
generator program for Windows, using the digital sound channel capabilities of your sound 
card and processing techniques to produce nature sounds.    This program could be used to 
mask out unwanted environmental noise and promote relaxation and concentration.    
Controls for Volume and Tempo allow the listener to tailor sound output to individual 
preferences.

RecAll for Win95, WinNT4, and Windows 3.1
RecAll works like a voice-activated recorder for your computer.    The program runs in the 
background, monitoring the microphone input of your sound card.    Sound above a settable 
threshold triggers recording of .WAV data to disk.    Recordings may be time-stamped.    
Suggested uses include a handy note-taker for ideas and dictation, unattended monitoring of
radio scanners, and security monitoring of your work environment.



MouSing for Win95 and    Windows 3.1
Create eerie sounds by moving your mouse.    This program is similar to a musical instrument
called a Theremin, which responds to the musician's hand movements in the air near the 
instrument, but instead of detecting hand movements, we use a mouse.    Movement in one   
direction changes pitch, and in another direction volume

AppLaud for Windows
Impress your friends!      Turn your sophisticated multimedia computer into one of those 
gadgets-that-turn-things-on-and-off-by-clapping-your-hands.    Applaud runs in the 
background, monitoring your sound card microphone input and detecting the noise 
signature of clapping.    Different programs can be launched for two-clap and three-clap 
signals.    A special "stealth mode" is implemented for the Sound Blaster 16 and some 
compatible sound cards, to allow simultaneous listening and sound output.    Sound card    
with Autmatic Gain Control (AGC) microphone input strongly recommended.



More great programs appearing soon!
We are currently developing more shareware and commercial-ware software applications for 
Win95/WinNT4 and Windows 3.1 .    For Internet surfers, a WEB page is available at

http://www.sagebrush.com/~sells/
or you can email 

sells@sagebrush.com 
to request for more details.    Or better yet, register this software and get our latest product 
catalog and request to be on our e-mail or mail list for new announcements!



MIDI instrument patches are numbered beginning with (0)zero.    This should not be selected 
for the vast majority of Windows MIDI configurations.



MIDI instrument patches are numbered beginning with (1)one.    This is the recommended 
selection.



For the large majority of sound cards, this option should be set to 1-Based Patches, but 
WinChime includes the other option just in case.    WinChime first comes up with 1-Based 
Patches Selected.    If Tubular Bells sounds like Tubular Bells, then you don't have to change 
anything.    If it sounds like a Xylophone, change to 0-Based Patches.



For the large majority of sound cards, this option should be set to 1-Based Patches, but 
WinChime includes the other option just in case.    WinChime first comes up with 1-Based 
Patches Selected.    If Tubular Bells sounds like Tubular Bells, then you don't have to change 
anything.    If it sounds like a Xylophone, change to 0-Based Patches.



Enable built-in timer.

Timer enable may also be toggled by menu selection or accelerator key control-T.      When 
the Timer is enabled, a "Tmr" appears on the status bar.



License Agreement
This software is Copyright 1995-1997 Sagebrush Systems, Inc.
All rights reserved.
WinChime is a trademark of Sagebrush Systems, Inc.

INSTALLATION OF WINCHIME ON YOUR COMPUTER SYSTEM IMPLIES AGREEMENT WITH THE 
TERMS AND CONDITIONS BELOW.

DISTRIBUTION OF WINCHIME, ITS ACCOMPANYING PROGRAMS AND DOCUMENTATION IS 
CONSIDERED AS IS.    SAGEBRUSH SYSTEMS, INC. OFFERS NO WARRANTIES OF ANY KIND, 
EXPRESSED OR IMPLIED.    THIS INCLUDES, BUT IS NOT LIMITED TO, WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.    UNDER NO CIRCUMSTANCES 
WILL SAGEBRUSH SYSTEMS, INC. BE LIABLE FOR ANY DAMAGES WHICH RESULT FROM THE 
USE OF THIS PROGRAM OR THE INABILITY TO USE IT.    EXCLUSION FROM LIABILITY INCLUDES,
BUT IS NOT LIMITED TO, LOST PROFITS, LOST SAVINGS, OR ANY OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES.

THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF NEW MEXICO.

WinChime is not free, public domain, or freeware.    Persons who have not purchased this 
program may use WinChime for a trial period of thirty days.    To use WinChime beyond this 
trial period, you must register and pay the applicable registration fee.



Timer Setup

Use WinChime's buit-in timer to add time variation and keep sounds interesting. The Timer 
Setup dialog provides several powerful controls that may be used separately or in 
combination:

· Fixed time duration.    WinChime plays for the specified number of minutes, then turns off.
· Fixed time schedule.    The start and stop time for sound output can be specified.
· Random play.    The user controls the average play time and average quiet time.    This simulates 
wind "gusts".

When the Setup dialog is adjusted to the desired parameters, click on the Enable Timer 
menu selection, if needed, to get a check mark to appear next to this menu item.

Here are how the various settings control scheduling:

FIXED PLAY LENGTH: Once play is started, by clicking on the Play button or by a timer action,
sound output will stop at the specified time.    Output could start again if Random length is 
enabled and random sleep time is non-zero.

FIXED PLAY TIME: If a Start Time is entered, this has the effect of simulating a Play button 
press at the specified time.    If the Stop Time is specified, this is like pressing the Stop 
button at the entered time.    Times should be entered in "24 hour" time, so 1:30PM should 
be entered as 13:30, or alternatively, as 1330 .

RANDOM PLAY: Once play is started, by clicking on the Play button or by a Fixed Time Start 
timer action, sound output will continue for an average of Random Play minutes and then 
sleep for an average of Random Sleep minutes.    This cycle will continue until the Stop 
button is clicked or a Fixed Time Stop timer event.

These settings may be combined.    Suppose we want WinChime to start playing at 7AM (as a
gentle alarm clock) and play for random intervals averaging one minute on and three 
minutes off.    Enable the Random Play and Fixed Time Play checkboxes, and enter 1 Average
Play Minutes and 3 Average Sleep Minutes.    The other edit fields may be left blank.



Updates for Previous Purchasers
If you have already paid for this product (either directly from Sagebrush,    by retail purchase,
or bundled with a hardware purchase) :

                Thank you!
You may continue to obtain several updates to the software by getting a Registration Code.    
This code allows you to use future versions of the program, available on the Internet or other
distribution channels, without being bothered by registration reminder screens.    The latest 
program version is always available on the World Wide Web, at 
http://www.sagebrush.com/~sells/

We have chosen the Registration Code method for updating programs, rather than sending 
out new Registered Program Disks for every major update, for your convenience, to keep 
shipping costs down and to reduce delays.

How to get a Registration Code
If you obtained    this program by retail purchase, mail in the registration card, with your 
Serial Number, and we will send your code.    Non-USA customers allow several weeks delay.

Alternatively, e-mail sells@sagebrush.com with your name, address, program name, 
program Serial Number, version number, date and store purchased.

Or, if necessary, send the above information by mail to Sagebrush Systems, PO Box 3094, 
Corrales, NM (USA) 87048.

If you purchased an earlier version of this program directly from Sagebrush, you won't have 
a serial code, but send the other information.



Getting Started
<Getting Started>



License agreement
<License>



Mail-Order Registration Form
<Registration_form>



Print registration form
<Registration form>



Setup Timer
<Setup Timer>



Troubleshooting
<Troubleshooting>



UPDATES
<Updates>






